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Introduction & Learning 

Intentions 
Introduction:  This workshop aims to upskill and develop teachers 

understanding of advanced modelling techniques in 
SolidWorks 2018. The workshop will further interrogate 
Surface and Solid Modelling techniques while also examining 
features such as Indent, Deform, Freeform, Combine, Curve 
driven Pattern, Fill Pattern, In-Context modelling and 
Advanced Mates. 

 

 

 

 

Learning Intentions: At the end of this workshop it is intended you will be able to: 

 Explore a modelling technique using planar and non-
planar geometry with zero thickness. 

 Understand and apply some ‘surfacing’ features in a 
SolidWorks design model. 

 Explore the use of features including Indent, Deform, 
Freeform, Combine, Curve driven Pattern, Fill Pattern, 
In-Context modelling and Advanced Mates. 

     
 Surface Modelling can be used to model complex designs within SolidWorks. 

 

 The transition from zero thickness surface geometry to solid objects is a 
necessary and fluid transition in advanced CAD modelling. 

 

 The appropriate use of advanced commands such as those outlined above, 
will significantly enhance realistic parametric modelling. 
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Study Lamp  

Base 

Open a new part from the SolidWorks Documents dialogue box. 

Select File. Click Save as on the standard toolbar. Save as Base in the Study Lamp folder. 

Continue to save periodically throughout the exercise. 

 

Create sketch  

Select the Top Plane in 

the design tree and 

draw a circle having 

180mm diameter. 

Extrude by 15mm. 

 

 

On a plane 50mm above the Top Plane, sketch 

the point as shown. 

 

In the Features commands select Loft Boss/Base 

and select the edge of the circle and the point. 

 

On the left hand side expand 

the start/end constraints. 

 

 

 

 

 

 

 

180mm 
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In the window select edge as shown and select Tangency To Face as the start constraint. 

Select the point in the window and 

select the Normal To Profile as the 

end constraint. 

Note the arrow direction. Set the 

height of each arrow to 1. 

 

 

 

 

 

 

 

 

 

Detailing 

On the Top Plane draw the sketch 

shown using the Spline command. 

Add the dimensions. 

Mirror about the centreline. 

 

 

In the Features tab, under the Curve command, select Split Line. 

 

 

On the screen select 

the face to split. 
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In the surfaces tab select Surface Offset.  

Select the face as shown and offset by 0mm. 

Still in the surfaces tab select the Thicken tool and 

thicken by 4mm. 

Untick the Merge result box. 

 

 

Select the Indent command. 

Select the part as the target body. 

Select the surfact as the tool body. 

Set the offset distance to 0.2mm. 

Make sure to tick the Cut box. 

 

 

 

 

 

Hide the Body. 

 

 

On/Off Button 

On the Top Plane draw the ellipse to the given dimensions. 

Select Split Line and select the sketch and the face to split. 
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In the surfaces tab select Surface Offset and 

offset the ellipse by 4mm. 

 

Select the Thicken command. 

Thicken by 6mm and untick Merge results. 

 

 

 

 

 

 

Select the Indent command . Select the target body and tool body as shown. 

Set the clearance to 0.2mm. 

 

 

 

 

 

The button now has a  clearance of 

0.2mm around it and sits into the base 

part to a depth of 2mm. 

 

 

On the Front Plane create a sketch. 

In the tools tab select Sketct Tools 

and then select Intersection Curve. 

In the drawing area select the top and 

side of the button. 

Accept. 
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The line of intersection between the plane and the 

button in now shown. 

 

Select the Spline command and draw the spline as 

shown. 

Add the following dimensions to the spline 

handles. 

 

Use the Trim command to trim off the excess. 

Accept the sketch. 

In the features tab select the Extrude 

Cut command to remove the top 

portion of the button. 

 

Add a 1mm Fillet to complete the shape of the button. 

 

Connection to Lamp Arm 

On the Front plane draw a Centreline to 

the following dimensions. 
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Create a plane perpendicular to this line going through the top 

point by selecting the line, then the point. 

 

 

Draw the sketch 

shown on this plane. 

 

 

 

Draw the sketch shown on the Top Plane. 

 

On the Front Plane draw the Splines shown to the 

given dimensions. Make sure to add the pierce 

relations. 

 

In the features tab select Loft 

Boss/Base to draw the feature. 

 

 

 

 

 

 

 

 

 

 

On the surface show, draw a sketch using the Slot, Circle, 

and Ellipse commands. Use the Trim tool and add the 

following dimensions. 
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Rename the sketch as Arm Profile. 

 

 

Extrude Cut by 40mm. 

 

Rename the extrude as Recess for Arm. 

 

 

Apply a High Gloss Plastic Appearance to the part. 

 

 

Save the part. 

 

Study Lamp Arm 

Select the Top Plane to draw a sketch. Open the Base Part also. 

 

In the design tree for the Base Part, select the Arm 

Profile sketch. When it is highlighted in blue press the 

Control + C on the keyboard.  
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Go into the new Arm part and press Control + V 

 

Select the dimensions command, and re-enter the 

dimensions. 

 

Select the midpoint shown, and the origin, and add a 

coincident relation between them.  

 

 

 

 

 

 

 

 

 

 

Rename the sketch as “Arm Profile” 

On the Front Plane draw the sketch to 

the following dimensions.  

Rename the sketch as “Arm direction” 

Using Sweep Boss/Base, create the 

feature. 

 

 

 

On the Front Plane draw a 

centreline from the centre point of 

the arc as shown. 
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Draw a new plane parallel to the Top Plane at the Centre point. 

 

Create a plane that is inclined to this 

plane and also goes through the 

centreline. 

Rename this plane as “5 degrees to 

Horiz”. 

 

 

 

 

On this inclined plane (“5 degrees to Horiz”) 

select the sketch command. 

In the Tools tab select Sketch Tools then 

Intersection curve.  

 

 

 

Select all the faces but not 

the inside curved face. 

The intersection line 

between the plane and the 

feature is now shown. 

 

 

On the Front Plane, draw a square using the 

polygon command. 
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Add a Pierce Relation between the centre 

point of the square and the line shown. 

 

 

 

 

 

Add a Parallel Relation between the bottom 

of the square and the centreline. 

Add a dimension of 2mm to the side of the square. 

 

 

 

 

Use Sweep Cut to remove 

the material as shown and 

then Mirror about the front 

plane. 

 

 

 

 

 

 

In the Features tab select Curve Driven Pattern as shown. 
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In the direction1 box, select the  

“Arc direction” sketch. 

Select the features to pattern 

from the design tree. 

Make sure offset curve and 

tangent to curve are selected. 

Input 28 for the number of 

instances.  

Add a spacing of 15mm.  

 

Accept. 

 

 

 

 

 

 

Use of Freeform tool 

Select plane “5 degrees to 

Horiz”. 

Find the line of intersection 

between the underside of the 

feature and the plane.  

To do this select Tools, Sketch Tools, 

Intersection Curve. 
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In the features commands select Extrude 

Cut and cut in direction 1 by 0.5mm. De-

select direction 2 and tick the thin 

feature box. 

Accept. 

 

 

 

 

Select Curve Driven Pattern in the features commands, and add the additional features as 

shown. 

 

The underside surface is 

now divided into four 

sections. 

To create the bulge effect, 

use the freeform feature 

on each section. 

 

 

 

Select Freeform from the 

features commands. 

 

Select the face onto which to 

apply this feature. 
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On the left hand side select Control polygon and select the Add 

Curves button. 

Move the cursor onto the surface, and click on the area to add the 

curves. They will appear as green. 

 

 

 

 

 

 

 

 

 

Activate the Add Points tab, and add 

points roughly in the centre of these 

curves. 

Click on the Add Points tab again to 

deselect this command. 

 

 

 

Double click on a point, and the 

triad will appear. Drag the Z arrow 

to create the deform. 

Drag the points on each curve for 

the best effect. 

Select the Zebra stripes to help to 

create a smooth curve 
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Accept. 

Repeat the process for the other faces on the 

underside of the Arm part. 

 

 

 

On the face shown, draw the sketch to the 

following dimensions. 

 

 

 

On the front plane draw the sketch 

shown.  

 

 

 

Use Centerpoint Arc to draw the 

segment shown. The CenterPoint 

being the same centre point as the “Arm Direction” sketch.  

 

Add a Pierce Relation between the top 

midpoint of the sketch and the arc. 

Select Sweep Cut to remove the material. 
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Accept. 

 

Apply a High Gloss Material to the Part. 

 

Save. 

 

 

Hood Support 

Open a new part from the SolidWorks Documents dialogue 

box. 

On the Top plane draw the following sketch using the 

Ellipse command. Trim the excess. 

 

 

On the Right Plane draw the following 

sketch using the Line and Spline 

commands. 
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Add a Pierce Relation between the arc and the outside corner of the profile as shown. 

 

In the features commands use the Sweep 

command to create the profile. 

Add an 8mm Fillet to the outside edge.  

 

 

Create a new plane parallel to the right plane at a 

distance of 65mm as shown. 

Draw the sketch 

shown. 

 

 

 

 

 

Extrude up to Body. 

 

 

 

On the Front Plane draw a semi-

circle tangential to the end, 

top and bottom edges of 

the part as shown. 
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Select Extrude Cut and Through All 

 

 

 

 

 

 

On the face shown draw the ellipse to the given 

dimensions. 

Extrude Cut through all. 

 

 

 

Draw the rectangle 

on the same face 

and add a fillet of 

0.75 to the 

corners. 

 

 

 

 

 

On the Front plane draw a Centre Point Arc having a radius of 

200 mm with the centre point vertically below the face of the 

part. The length of the arc is 45mm, and the arc starts 1mm 

below the top face of the Part as shown. 

 

 

200mm
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Add a Pierce relation between the arc and the Midpoint of the profile. 

 

Use Sweep Boss/Base to complete the feature. 

 

 

On the front face draw the Circle shown.  

 

 

 

 

 

 

Select the Extrude command. 

Input the following information. 

The extrusion begins 

38.5mm from the sketch.  

Select the body as shown, 

to indicate where the 

extrusion ends. 

 

Draw a Circle diameter 4mm on this face, and 

Extrude it by 5mm. 

 

Mirror these features about the front plane. 
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Apply an Appearance to the Part. 

 

 Save. 

 

 

Lamp Hood 

On the Top plane draw an Ellipse to the following 

dimensions. On the Front Plane select the Spline 

command to draw the following sketch. Add Pierce 

Relations to connect the spline to the sketch on the top 

plane 

 

 

 

 

 

Select the Right Plane to draw the three point Spline 

shown. Add the Pierce Relation to connect the sketch to 

the two other sketches. 

 

Select Filled Surface in the 

Surfaces Tab. 
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Create a plane parallel 

to the Top Plane a 

distance of 35mm 

above. 

 

 

 

 

To find the line of intersection 

between the plane and the hood 

shell, select Tools, Sketch Tools and 

Intersection Curve. 

 

 

Click on the face of the hood and click the 

accept. 

 

 

 

Still in this sketch, draw a Circle diameter 

100mm and change the intersection line 

into a centreline. 
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Accept the sketch. 

 

Create a new sketch on the Top Plane. Select the 

offset command to draw an ellipse 3mm inside 

“sketch 1”. 

Accept the sketch. 

 

In the surfaces tab select Lofted Surface. 

 Be careful when selecting each profile. 

Try to keep the green dots horizontal,in 

order to achieve the best shape.   

 

 

Accept. 

 

 

 

 

 

Select the Surface Fill command. 

 

Select the edge highlighted. 

Accept. 

 

Select Surface Fill again and select the edges on 

the top plane as shown. 

Accept. 
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Two new surfaces have been applied. 

 

 

 

 

Select the Surface Knit command, 

and click on all four surfaces in 

the drawing area to knit. 

Tick the merge entities box. 

Accept. 

 

 

 

 

Select the Thicken 

command. 

Add a thickness of 1mm to 

the inside. 

Tick the box to create solid 

from enclosed volume. 

 

Accept. 
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If the box to “create solid” is not ticked, and 1mm thickness is applied, the enclosed space is 

not filled as shown. 

 

 

 

 

 

 

 

 

 

 

 

Recess for lights/ Diodes 

 

On the face shown draw the Circle 

diameter 5mm.  

Draw a Centreline from the centre to 

the perimeter. 

Select Extrude Cut, and extrude cut 

the circle by 5mm. 

 

 

Select Fill Pattern in the feature commands.  

 

 

 

 

Activate the Fill Boundary box, and on the drawing area, select the face. 
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Select the Pattern layout as 

shown. 

 

Set the spacing 

between 

holes to 25mm. 

 

Set the number of 7. 

 

Activate the direction box and 

select the centreline.  

Press the selected features 

button and select the Cut Extrude 

from the design tree. 

 

Accept. 

 

 

 

 

 

 

Creating the recess to receive the Hood Support 

 

Create a Plane 45mm above the Top Plane. 

 

Under the Insert tab select Part. 
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Select the Hood Support. 

In the display on the Left hand side make sure 

Solid bodies, Planes and Locate Part boxes are 

ticked. 

 

 

 

 

 

 

Drop the Hood support part near the Hood part. 

The following mates window appears. 

 

 

Mate the Front Planes as shown, and 

select Add. 

 

 

 

 

 

Mate the Right Planes and select Add. 

 

Mate the plane that was created 45mm above the top 

plane with the underside of the hood support, as shown. 
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To hide the planes, click on the View tab. Select Hide/Show, and then Planes. 

 

 

 

 

 

 

 

Select the Indent Command. 

Select the lamp hood as the target 

body. 

 Select the support as the tool body. 

Add a 0.2mm clearance.   

Tick the cut box.  

Accept. 

 

 

 

 

 

 

 

Hide the Hood Support part. 

 

Apply a High Gloss Plastic to the part, and a 

Chrome finish to the inside faces. 
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Create a Plane parallel and at a distance of 55mm 

from  the Right Plane. 

 

Draw the circle shown. 

 

 Extrude cut by 10mm. 

 

 

 

 

 

Save the Part. 

Study Lamp Assembly 

The parts for the assembly must be saved in the same folder. 

On the top of the screen select File, New. 

Select Assembly in the SolidWorks Document dialog box. 

Click OK. 

 

Bring in the Base Part, and select the green tick to fix it to the origin. 

Bring in the Arm and apply the required mates. 

 

Bring in the Hood Support. 

Mate the  faces as shown. 

 

 

Add a tangent mate to the  Top of the Support, 

and  to the top  of the recess in the Arm, as 

shown. 
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Finally select both faces as shown, and in Advanced Mates 

select angle mate. 

Set the minimum angle to 0 degrees. 

and the maximum angle to 12 

degrees. 

Accept.  

 

 

The support is now free to move in the arm to these values. 

 

 

 

 

 

Bring in the Hood. 

Apply the following concentric mates. 

 

 

 

Mate the front planes of each part 

 

 

Finally in Advanced mates, select Angle mate and 

select the two faces shown. Set the minimum angle to 

0 degrees and the 

maximum angle to 25 

degrees. 
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Accept. 

 

To Add the Cable using In-Context Modelling 

In the Assembly, create a plane parallel 

to the front plane through the centre of 

the arm, as shown.  

  

 

 

 

 

 

Select the down arrow under Insert Component, and select 

New Part. Select this new Plane to draw a sketch. 

Create the sketch shown using the Line, Spline, and 

CentrePoint Arc commands. 

 

 

 

 

 

 

In the features commands, select Swept Boss/Base. 

Select circular profile and a diameter of 3.5mm. 
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On the top right hand side of the display area, select the icon shown to exit and 

return to the assembly. 

 

 

 

 

 

 

 

 

 

 

 

 

The Task is Complete 
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